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now, but I’m using a new utility from Connectix: SleepDoubler.

This copy of the WP Mac News is a special one for me, because it’s my
last. I’m leaving the good people at WordPerfect and going back to
school. I still plan to contribute articles to the News now and again, but
I’m handing on the editorship of the News to the competent and eager
hands of Lisa and Cliff. 

I’m going to miss watching each issue take shape, assembling the
articles, hacking out layout, reading the Mail from our erudite reader-
ship. I’m getting verklempt!

Okay, I’m fine now. My thanks to those who have helped get the News
started, including Dave Nielsen, Dave Moulton, the entire Mac Team,
Heather Boyer, and all the readers who told us they were glad that the
News exists.

Oh, and if you like my writing, offer me a job. I do documentation. 
Thanks, and adios. —Daniel 
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You can reach us by e-mail at macmail@novell.com, or by fax at

(801) 222-6980. We welcome your comments, feedback, tips &

tricks, and questions. Due to the sheer volume of mail we receive,

you may not get a personal reply. If you need support for a

WordPerfect product, use the support number in your User’s Guide.

Who ever wrote the copy for your ad with the lead lines:

“Used to wear bell bottoms. Used to play the tuba. Used to use Microsoft Word.” 

has not run this ad up enough flag polls before it was released. My thoughts: 

1. There are quite a few hundred thousand people who have or are still wearing bell
bottoms in the US Navy, and they are the most computer-based branch of the armed
forces. 

2. There are a whole lot of tuba players who are active computer users as well. I am not
only a computer user who plays the tuba on a professional level, I also have designed
quite a few computers, test equipment and peripherals over the last 20 years, using CAD
and CAM systems. 

3. While I have not used the latest Microsoft Word, I have used earlier versions on my
Mac for the last 6 years, and have not found a better word processor yet.

So, your ad has lost my possible interest by your poor choice of “what is 
(not) hip.” I think you will be hearing from other (ex)-Navy, tuba 
playing computer users in the next few weeks. —David M. Richoux

—We have heard from a few of
our tuba-playing readers, and I
understand how tuba players may
feel attacked, especially when tuba
playing is linked with (shudder)
bell-bottoms.

I haven’t talked to the ad agency on
this one, but I get the feeling that
this was not an attempt to make a
“List of Things Uncool.” This is a
list of things in this man’s PAST,
including (fortunately for him)
Word.

I apologize to all tuba players for
any insult, even unintentional.
(Same goes for any Comet-driving
mood ring wearers we may have offended by the other ad.) 

For the sake of perspective though, I should mention that lawyers are expected to endure
this sort of abuse every day of their miserable lives.
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Help - my new PowerMac 9500, crashes very frequently with WordPerfect 3.1, error
11. I have reinstalled, started without extensions etc. It keeps on crashing. Any suggestions,
or do I have to wait for 3.5? —Jesper Laustsen

—When Apple came out with the 7.5.1 update, almost all the problems with Error Type
11’s on PowerMacs magically disappeared. So make sure you’re using System 7.5 with an
updater. Any problems after that, talk to us here.

I was teaching Intermediate WP to a student, and we were going over merges. We
had just finished making the data and form files, and merging the two together. Then we
used the same data file to merge labels, and the student told me that the data file we were
using “wouldn’t do, and she’d have to make a new one,” because her job demanded
mailing labels be in ALL CAPS. 

Rather than doing that, we did the merge with the existing data file anyway. Then I had
her pull down Edit to Select All, then Style to Uppercase. Well, she just about jumped up
and gave me a kiss, she thought that was so wonderful. —Mike Madsen

Is there an e-mail address for technical support for Word Perfect for the Macintosh?
—Robert Slavey

—Yes, wptech@novell.com

Be sure to include a valid serial number or PIN when you mail.

Much has been said about the arrival of WordPerfect 3.5. But it is now 19 August
and no one has yet seen it. Can you please tell me when it will be available in the UK and
at what price. Please give me the prices for both the full version and upgrade from
3.1.—Brendan Martin

—Right now we only have information for the US and Canadian release. We're expecting
WordPerfect 3.5 to ship in early-to-mid September. The full price is $189, and the upgrade
price is $89. We’ll keep you posted on the UK release and others.

I was reading the magazine NetGuide and saw a WP ad for a WP Internet add-on. 
However, the ad only mentioned Windows. Is there a Mac version available or soon to be
available? My new job will include WWW duties and a WP HTML editor would be a
godsend. —Brent Heustess

—Yup, check the Extra Edition of the WP Mac News for more info. The Web URL is 
ht tp: / /netwire.novel l .com/ServSupp/mac/macnews/jul_95ex/index.htm

and the ftp address is 

ftp.wordperfect.com/pub/wpapps/mac/mac_news/jul_95ex.hqx 
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Drop Shadow

When you want a piece of text to really stand out, don’t just type it. Instead, create it as an
object in WordPerfect’s Graphic Layer. Then duplicate the object, make the copy a lighter
gray (using Style/Text Color) , and place it in back, to the lower right (as you see in this
figure). It’s a good way to give a 3-D look to your text.

Typeover

Do you like Typeover? This hold-over from the DOS world has wormed its way into the
hearts of at least a couple of Mac users. Here’s how to make it a part of your everyday life, if
you must. 

Go to Edit/Preferences/Keyboard, highlight Typeover in the list of commands, and click
the Assign button in the upper right. You’ll get a dialog asking you what keystroke to
assign. Press the keystroke you want (how about Shift-Help?) and click 
Assign. Then click Done to leave the Keyboard dialog.

Once you turn Typeover on, it will stay on until you turn it off again 
with the same keystroke.

Let’s Talk Character Styles

Usually, a style applies itself to a whole paragraph at a time. But from time to time, you
may want to create a style that applies itself only to some characters within a paragraph. It’s
not very well-known, but this ability exists in WordPerfect 3.1 and later.

It used to be that you’d go to Edit/Preferences/Environment, and choose Character from
the Format menu. Now that menu item has been removed. But—the big secret—the
equivalent macro token still exists!

So create and run the following one-line macro:   F o r mat t ing  (Character)

That’s it. You’re now set up for Character Styles, and you can highlight a few charcters and
assign a style to them. If you ever want to set it back to Paragraph, go to Edit/Preferences/
Environment and choose “Paragraph” from the Format menu.

A word of caution: There may have been some very good reasons why the Character
formatting option was removed from the Format menu. Be aware of this, and act
accordingly. (But it works great for us.)

Append to Clipboard

Usually, the Clipboard can only hold one thing at a time. When you Cut or Copy
something new, out goes the old. But if you highlight some text and press 
(Command–Shift-A), you add the new stuff to the old stuff. 
Paste, and it all shows up. 
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Mastering Macros
by John Rethorst

Menus

o far, we’ve written and implemented basic commands that are fairly linear: press a
keystroke, get an action. Let’s take a big jump up from this, and write a macro or two

that gives the user a choice, expressed on a menu. 

Basic Menus

To show or hide white space (margins, space for headers, footnotes etc.) more easily than
going to Environment in Preferences, try these two one liners: 

White Space (Show)

and 

White Space (Hide)

or, rather than have two separate macros (or 20, for another purpose), we can give the user
a menu with all the options in one place: 

Menu (Var01;"White Space";{"Show";"Hide"})

If (Var01=1)

White Space (Show)

Else

White Space (Hide)

End If

which does the following: 

1. The Menu command has a variable as its first parameter: a number representing the
user’s choice (e.g. 1 for Show; 2 for Hide) will go into Var01. 

2. “White Space” is the title of the menu. 

3. The words within the curly brackets form a list; in this case, they’ll be the items on the
menu. 

4. The following If statement uses the value of the variable assigned in the Menu
command. If the user selected the first item on the list, Var01 would have the value 1.
If the user had selected the second item, Var01 would have the 
value 2. But, since there are only two choices on the menu, we 
used an if/else structure as the simplest way to do it. 
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Cases and Labels

If we have more than two menu choices, we could do more if/else statements or, more
conveniently, tell WP that in case Var01 is 1, do this, and in case Var01 is 2, do that, and in
case Var01 is 3, do the other thing. 

For example, you can set formatting (in Environment in Preferences) to either Paragraph
or Single Paragraph, nice options for flexibility, but you have to go into Preferences to do it.
If you remember WP 1.x or 2.0.x, you know another formatting option, Character (my
favorite much of the time). The difference is: say you have your insertion point in the
middle of a single-spaced paragraph, and you choose double spacing from the Layout Bar.
With Paragraph formatting, all lines in the current paragraph and all succeeding
paragraphs (until a style takes effect) become double-spaced. With Single Paragraph, only
the paragraph containing the insertion point is affected. With Character, only the text
following the insertion point is affected. Ready availability of all three significantly
increases power in formatting. 

This macro uses the Formatting command with the parameters Character, Paragraph and
Single Paragraph. It posts a menu to assign a value to a variable (Var01), which will be 1, 2
or 3 depending on the user’s choice from the menu list. The Case command then looks at
Var01 and assigns a Label according to its value. Macro execution then goes to that label.
(Remember, we learned about labels last month, using the Go 
command to send macro execution to one label. This is just a 
little more slick, having the macro branch to one label or another, 
depending on the value of a variable.) 

The list in curly brackets in the Case command are the labels corresponding to the values
of Var01. The Cancel label following the curly brackets is the default label, to which the
macro will go if the user clicks the close box in the menu (that is, doesn’t put anything in
Var01). The End Macro command following each label and its associated command keeps
the macro from going on to read and execute subsequent lines, thus resetting the
formatting. This command isn’t needed at the end of a script since a macro ends naturally
when it runs out of code. 

Menu (Var01;Set Format to:";{"Character";"Paragraph";"Single Paragraph"})

Case (Var01;{1;Character;2;Paragraph;3;Single Paragraph};cancel)

Label (cancel)

End Macro

Label (Character)

Formatting (Character)

End Macro

Label (Paragraph)

Formatting (Paragraph)

End Macro

Label (Single Paragraph)

Formatting (Single Paragraph)
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For an added touch of elegance, let’s tell the user what the current setting is, using the
read-only variable FormatOrientation, which holds the value 0, 1 or 2 depending on the
parameter. Add these lines to the beginning of the macro, so that the last line here replaces
the menu command: 

If (FormatOrientation=0)

Assign (Var02;"Character")

End If

If (FormatOrientation=1)

Assign (Var02;"Paragraph")

End If

If (FormatOrientation=2)

Assign (Var02;"Single Paragraph")

End If

Menu (Var01;"Format now: "$Var02$". Set to:";{"Character";"Paragraph";"Single

Paragraph"})

and enjoy much more flexible formatting. 

Call

Use of menus invites sophistication in flow commands. The user’s choice sends macro
execution to one of several different labels, which is fine as long as all those labels do
different things. Sometimes, though, they contain some identical steps. Rather than repeat
those in each label, it’s easier to refer execution to another part of the script, run the
commands there, and then return. Here’s a quasi-macro example: 

Menu (Var01; "First Day of Vacation";{"Sleep All Day";"Go Fishing";"Play Golf"})

Case (Var01;{1;sleep;2;fish;3;golf};cancel)

Label (cancel)

End Macro

;=====================================

Label (sleep)

Sleep

End Macro

;=====================================

Label (fish)

Get Up

Wash

Brush Teeth

Get Dressed

Eat Breakfast

Put Fishing Rod in Car
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and so on, and you can see that the next label, “golf,” will include the same commands
between “Get Up” and “Eat Breakfast,” inclusive. In a real macro, that could be many lines
of code, repeated for a dozen menu choices. 

A shortcut is to use the Call command, which will send execution to a specified label and
continue until a Return command is encountered. Execution then returns to the line
immediately after the Call command. So part of our vacation macro would look like: 

Label (fish)

Call (firstthing)

Put Fishing Rod in Car

;=====================================

;and so on

;=====================================

Label (firstthing)

Get Up

Wash

Brush Teeth

Get Dressed

Eat Breakfast

Return

with the “firstthing” label somewhere out of the way, 
perhaps at the end of the script. 

Execution now, assuming the user’s going fishing, goes to the label “fish” and then to the
label “firstthing.” Upon seeing “Return,” the macro goes back to the line right under the
Call command, which is “Put Fishing Rod in Car.” Note that the Return command is not
anything like Hard Return, which moves the insertion point down one line in the
document. 

Here’s a real example: 

Menu (Var01;"Type and Format";{"Alpha";"Beta";"Charlie"})

Case (Var01;{1;alpha;2;beta;3;charlie};cancel)

;=========================================

Label (cancel)

End Macro

;=========================================

Label (alpha)

Call (format)

Type (Alpha)

End Macro

;=========================================

Label (beta)

Call (format)

Type (Beta)

End Macro

(continued)
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;=========================================

Label (charlie)

Call (format)

Type (Charlie)

End Macro

;=========================================

Label (format)

Font Name ("Palatino")

Font Size (72)

Attribute (On;Italics)

Attribute (On;Bold)

Return

Here’s those quizzes again
Answer to the quiz last month: just replace the line Print (Document) with, for example: 
Select All

Font Name ("Palatino")

Quiz for this month: see if you can rewrite the menu macro that shows or hides white
space, using case and labels.  

* * *

John Rethorst, author of Teach Yourself WordPerfect, sees in a macro 
script what many see in a sonnet.

The contents of this article are copyright © 1995 John Rethorst.

All rights reserved. Used with permission.
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QuickFormat
by Michael Madsen

he QuickFormat macro emulates the QuickFormat feature found in WordPerfect 6.1
or the Format Painter found in Microsoft Word 6.0.  It allows the user to quickly copy

text formatting from one place to other places in the document in just one click.

To use the QuickFormat Macro:

• Place the cursor within text that contains the text formatting you wish to copy. 
Selecting text is not necessary, but it will still work.

• Run the QuickFormat Macro.  A dialog will indicate…

• Click or Select the words or phrases to copy the text formatting to.  
Click or select as much text as necessary.

• When finished, press Command-Period to turn QuickFormat off.
[Mike was once one of our fellow WordPerfect gurus, and my macro mentor. He can program any 

macro I can, using half as many lines. —Ed.]

Random Color

a very silly macro by Daniel Midgley

Ever get tired of that boring old blah screen? Want to spice up your palette? Then take a
spin on the color wheel of chance! When you run the Random Color macro, there’s no
telling what colors you’ll end up with. (Is that a good thing? You be the judge.)

Just run the macro, and you’ll see this menu:

If you choose A, you might just get some colors you like. Actually, it’s more likely that
you’ll wind up with some horrible colors. There’s just no telling.

But if your screen does look awful, you can always try choosing A again, or choose B to put
the colors back the way they were when you launched WordPerfect. 

The macros described in this section are contained in a WordPerfect file called

“September Macros Read Me.” It was included when you downloaded the

WordPerfect Mac News. The file also contains instructions for moving these

macros to your Library, as well as more detailed help and instructions for use.

page 10



WordPerfect Mac News September 1995

Merge
by Daniel Midgley

The Basics

 merge (sometimes called a mail merge) is what you use when you need to send a
form letter to a bunch of people, and you want to personalize the letters by placing

each person’s name and other relevant information into each copy.

WordPerfect’s Merge feature allows you to accomplish this, and this article will help you
get started.

What You Will Need

In order to merge, you will need:

• A data file. This is your list of everyone’s names, addresses, and so on. You need to
format your list of names a certain way in order for the merge to work.

• A form file. This is the form letter you’re sending to everyone. 
It also needs certain things for the merge to work.

• Eventually you’ll also need a third, untitled document to merge the 
form file and the data file into, but we’ll deal with that in a minute.

Here’s a sample DATA file. 

Each person’s information is considered a separate
record. The chunks of information within a record are
called fields.

This data file has three fields. Yours can have as many
fields as you want, with any information you want to
include.

The names come first here, so they’ll be known as
Field 1. The next field will be called Field 2, and so on.

Notice that every field has an <End of Field> command
after it, and every record has an <End of Record>

command after it. You can place these in your data file
by clicking on the  and  buttons
on the Merge Bar.

Also notice that the last field in each record should have an <End of Field> code, even
though it has that <End of Record> right after it.

There are no empty spaces between records. There’s also no formatting 
(fonts, sizes, etc.) in this data file.

A field can be more than one line long, like the addresses in this 
example.
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Now here’s a sample FORM file.

Notice how there’s a <Field> command wherever a piece of
information is going to be plugged in. You get these by clicking on the 

 button on your Merge Bar, and typing the appropriate number.

The <Date>  command will plug in the current date when you run the
merge.

You can use fields over and over again. If you wanted, you could put
<F ie ld :1>  into your form file twenty times, or not at all. 

The Merge

Now that you’ve got your data and form files created, save them both and close them. 

(A hint: I have found it helpful to include the words “data” and “form” somewhere in the
names of the respective files when I save them. That way, I can keep them straight.)

Open a new untitled document. Open the Merge Bar, and click on the  button.

First, WordPerfect will bring up a dialog box asking you for the FORM file. Find it within
this box, and click Merge. 

Then WordPerfect will ask you for the DATA file. Find it, and click Merge.

When the merge is done, the information from the data file will be 
plugged into the appropriate spots in the form file, within this new 
document. Now you can save this merged file, or print it.

Define Names

Instead of having to call your fields <F ie ld :1>  or <F ie ld :2> , you can give them names.
Here’s how it’s done.

This DATA file has been modified for field names.

It needs to have a <Define Names> command added at
the top. You’ll find it under the  menu on your
Merge Bar. 

On the same line as the <Define Names> command, type
the name you’d like to give to the first field. Press
Return. Do NOT put an <End of Field> command.

Type the name of the next field on the next line, and so
on for the rest of the fields. Then, put an <End of Record> command on its own line.

Save it and close it. Your data file now has names defined for its
fields.

To refer to these field names in the FORM file, 
click the  button on your Merge Bar, then 
type in the name of the desired field in the Field 
Name box. 
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Or, click on the Get Field Names button, choose the data
file, and pull down the Field Name box to get the name,
as seen at right.

Other Methods Of Creating a Data File

What if your data is already in a database program like
FileMaker Pro, and you don’t want to have to type it all
out again in merge format?

No problem. WordPerfect version 3.1 and later can use database exports as data files.

You’ll need to export a copy of your database as a tab-delimited or a comma-delimited file.
(Check the documentation for your database program if you’re not sure how to do this.)
Then, when you merge and WordPerfect asks for the data file, just select the exported copy.
The files will merge as usual.

If you’re starting from scratch, there’s no easier way of creating a data file than with a table.
Create a table, with one column
for each field. Each row will be a
separate record.

Keyboard Fun

The <Keyboard>  command will allow you to type in data as you’re merging. It’s even
possible to do a merge without a data file, using <Keyboard>.

You put the <Keyboard>  command in your form file by clicking the  button. 

When a merge finds a <Keyboard>  command, the merge will stop and wait for you to type
whatever you like. To make the merge continue, press F12, or click the  button
on the Merge Bar.

Frequently Asked Questions about Merging

Is there a way to print my data file without the <End of Field>  or <End of Record> codes

showing?

Yes. Click the  button on your Merge Bar. The codes will change to tiny symbols
( ). They do not print.

I just did a merge to create form letters, but now how do I do labels for all these people?

First, run the Labels macro (Tools/Macro/Labels) to create a form file 
for your style of labels. Then merge this labels form file with the same 
data file you used to create the original form letters. 
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I clicked on a graphic, went to Tools/Graphics/Options, and deselected “Wrap Text

Around Box.” Now the graphic is behind the text, and I can’t select it again. How can I edit

the graphic now?

Just Command-Click on the place where the graphic
was. You’ll see the frame around the graphic, and
then you can edit it, move it, turn “Wrap Text
Around Box” back on, or whatever else. 

 I have been trying to use the Borders that came with the WP Extras disk in new

documents I create, and can't figure out how to resize them to fit my documents correctly. 

What am I doing wrong?—Lise R. Zawlocki

Go into the Watermark layer (Tools/Watermark/New), then choose
Insert File from the File menu. Insert a graphic you’d like to use. Then
resize the graphic (as seen at left), and close the Graphic Editor.

The border you selected will now be in a layer 
underneath your text, and it will repeat itself 
on every page.

Sometimes when I print, I get this message. How can I stop it from coming up?

Usually, this means that WordPerfect
and the System are taking up all of
the Mac’s memory, and there’s not
enough left over for the printer to do
its thing. 

You should DECREASE the amount of
memory WordPerfect is using. To do
this, first quit WordPerfect. Click once
on the WordPerfect application icon,
and then choose Get Info… from the
File menu. 

You’ll see an info box like the one at left. Type
a lower number in the “Preferred size”  box.

Start by making it 200K lower than the
existing number, and try printing from there.
Repeat, if necessary. 
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We welcome your comments, suggestions, letters, etc.

• What did you like about the WordPerfect Mac News?

• How was the layout? (Easy to find things, not too cluttered, graphics helpful?)

• What would you change about the WordPerfect Mac News? 

• What features would you like to see highlighted in a future issue?

• Which do you use?    o  Mac    o  DOS    o  Windows    o  UNIX    o  Other

• Do you read this magazine on the screen, or do you print it?

o  Read on screen o  Print it out

• Where did you find the WordPerfect Mac News?

                                                                                                                                                              

• On the Macintosh, would you describe yourself as…

o  A beginner o  A fairly proficient user o  A power user

• On WordPerfect, would you describe yourself as…

o  A beginner o  A fairly proficient user o  A power user

You can reach us by e-mail at macmail @ wordperfect.com, by fax at (801) 222-6980, or “snail mail” to WP Mac News, MS ORM

G-1512, WordPerfect/Novell Applications Group, 1555 N. Technology Way, Orem UT 84057-2399.

Send your letters, requests, ideas for features, and tips & tricks to us! We reserve the right to edit any material received for

content, clarity, and length. By submitting material to the WordPerfect Mac News, you agree to assign any and all rights, title,

and interest which you may have to your submission material and any work Novell Inc. derives from such submission material

to Novell Inc., unless otherwise specified.

The WordPerfect Mac News was created using WordPerfect 3.1 for Macintosh. The headings and the link buttons were

created using ColorIt!™ 2.3 by MicroFrontier, Inc. Then the whole thing was printed to WordPerfect Envoy. WordPerfect 3.1,

Document Experts, and WordPerfect Envoy are trademarks of Novell, Inc. ColorIt!™ is a trademark of MicroFrontier Inc. Apple

and Macintosh are registered trademarks of Apple Computers Inc.

NOTICE PLEASE READ: You accept this information with the understanding that Novell, Inc. makes no representations or

warranties as to the suitability of this information for your particular purpose, and that to the extent you use or implement this

information in your own setting, you do so at your own risk. In no event will Novell, Inc. be liable for any damages, whether

consequential, incidental, or special, arising out of the use of or inability to use the information provided herewith. Copyright

Novell Incorporated ©, 1995. All rights reserved.

If you do print out the WordPerfect Mac News, please recycle it.  
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